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OBJECTIVES
The intent of this experiment is two fold: to familiarize the student with some of the areas that OSI has defined as management functional areas and to provide the student an understanding of the Simple Network Management Protocol (SNMP) and its use in network management.  This lab will accomplish this by examining the network, in-depth, through the exploration of MIBs.  Three different software programs will be utilized today: SNMPUTIL, MG Soft MIB Browser and HP OpenView.

INTRODUCTION

Computer networking has become a critical production tool for many businesses and organizations.  A failure of networks or not well-designed networks can possibly cause a lost of millions of dollars.  Efforts on how to manage a reliable, cost-effective, and secure network have, thus, become an important issue for many network users.  To address this issue, International Organization for Standardization (OSI) has defined 5 management functional areas as network management guidelines.  The 5 areas are fault management, configuration management, accounting management, performance management, and security management, and are explained in the following table.

	Fault management
	The facilities that enable the detection, isolation, and correction of abnormal operation of network objects

	Configuration management
	The facilities that enable the control, add, delete, and modify of managed network objects.

	Accounting management
	The facilities that use to generate charges or identify costs of usage of managed network objects.

	Performance management
	The facilities that use to analyze the effectiveness of managed network objects, such as utilization of BW and server processing power.

	Security management
	The facilities that use to prevent hazardous action/behavior from damaging the normal function of managed networks.


In our lab, we will emphasize on the fault and performance management areas.  We will learn how to collect data and analyze the data by using several different network management tools.

One way to achieve network management tasks, such as the five areas specified by OSI, is to perform a regular “network audit.”  Network audit is a serial of steps that are designed to facilitate network management.  It covers all aspects of the physical and logical layout.  Those steps include network documentation, baseline creation, and network health analysis.  The network documentation is a process of bookkeeping network components.  For example, it can include hubs, routers, and servers, their physical locations, the number of interfaces on a router, the processing power of a server, the user of a host, and so on.  Detailed network documentation can simplify fault discovery, troubleshooting, and maintenance of networks.  To see the power of network documentation, image a user called and reported that he/she cannot access a network. A network technician can inspect whether the link between the host and hub is good by quickly checking the light indicator of the hub port status (on or off). Without the network documentation, which records the physical location of the user host and the hub port of the host connecting to, this fault discovery is hard to be achieved quickly.  To be able tell an abnormal activity of a network at one point, one should have a reference of normal network status to compare to.  The reference can be acquired by collecting the status of networks in the normal operation of the network, which usually include the network utilization and the server CPU usage over a period of time.  This type of reference is known as a network baseline. The primary scope of network health analysis can be divided into the physical, data link, and network layers of those in OSI model as shown below.

	OSI Model
	Examples of Check Points
	Network Audit

	Network Layer
	Responding time, protocol discovery, top senders, traffic analysis
	Evaluate the Network Health

	Data Link Layer
	Link utilization, broadcast frame, collision, top senders
	Checking the Data Link Health

	Physical Layer
	Wiring, connectors, NIC
	Evaluate the Physical Layer


Simple Network Management Protocol (SNMP)
The Simple Network Management Protocol (SNMP) communicates management information between a manager and agents. The manager can be any machine running management software, while the agent is any network device running agent software or supported by an agent proxy.  Network devices include routers, hubs, switches, etc.  SNMP was designed to work in a multi-vendor environment and operates over UDP (User Datagram Protocol).  See Figures 1 and 2 for the manager and agent protocol stacks.  

· Management applications are the processes that allow you to initiate management tasks and collect management information.  Three types of messages are issued by a manager:

· GetRequest

· GetNextRequest

· SetRequest




Figure 1:  Management Protocol Stack
· Agents are processes running on the network device.  The agent interprets incoming SNMP messages. Agents respond to GetRequest, GetNextRequest, and SetRequest with GetResponse.  An agent may also issue a trap, which is a message caused by exceeding a threshold defined on the agent device.  Network objects that do not have the agent software loaded will return a message stating the agent software is not loaded when queried by the manager application's GetRequest—and in some cases they will not respond at all to the GetRequest.




Figure 2:  Host Protocol Stack

· Proxy agents accommodate devices that do not support SNMP.  The management station queries the proxy.  The proxy agent then queries the device using the management protocol supported by the device.  The proxy agent then receives replies from the device and sends them back to the management station via SNMP.

RMON
A supplement to SNMP is RMON.  RMON debuted in 1991 and extended management capabilities to the LAN.   In 1996 RMON was extended by RMON2.  RFC 1757 describes RMON devices as:

Remote network monitoring devices, often called monitors or probes, are instruments that exist for the purpose of managing a network. Often these remote probes are stand-alone devices and devote significant internal resources for the sole purpose of managing a network. An organization may employ many of these devices, one per network segment, to manage its Internet. In addition, these devices may be used for a network management service provider to access a client network, often geographically remote.

Management Information Base (MIB)

Network Management applications rely on a Management Information Base (MIB) that contains definitions of the objects being managed, the agents that are available, and the requests that have been made to agents.  The management database contains definitions of each type of object.  

MIB objects are conceptually organized in a hierarchical tree structure.  Each branch in the tree has a unique name and numeric identifier.  Intermediate branches of the tree serve as a way to group related MIB objects together, as illustrated in Figure 3.  A MIB object is uniquely identified (named) by its place in the tree.  A full object identifier consists of the identifier of each branch along the path through the tree hierarchy.  For example, to access the system group, the correct identifier would be 1.3.6.1.2.1.1.  For more information on MIBs and their structure, please refer to the references at the end of the lab.




Figure 3:  MIB Structure
HP OpenView Network Node Manager

HP OpenView NNM is a comprehensive set of tools and services you can use to perform fundamental tasks in managing a distributed TCP/IP network.  The OpenView tools provide both management applications and agent software using SNMP protocol.  Different manufacturers such as Cisco and Bay Networks provide the agent software. 

SNMPUTIL

SNMPUTIL is a command line SNMP utility that enables the user to get SNMP information from an SNMP host on the network.  This raw utility is part of the Resource Kit for Windows 2000 Operating System.  

MGSoft MIB Browser

MG-SOFT MIB Browser Professional Edition with MIB Compiler is an SNMP MIB Browser running on Microsoft's 32-bit operating systems (Windows 95, Windows 98, Windows ME, Windows NT, Windows 2000). MIB Browser lets you monitor and manage any SNMP device on the network (i.e. file or database servers, routers, hubs, switches, bridges...) by using the standard SNMPv1, SNMPv2c and SNMPv3 protocols.  MIB Browser allows you to perform the SNMP GET, SNMP GETNEXT, SNMP GETBULK and SNMP SET operations. Besides, the software lets you capture SNMP TRAP packets sent from arbitrary SNMP devices on the network.  MIB Browser can monitor several SNMP devices simultaneously and contains features like SNMP Table viewer, logging capabilities, real-time graphical presentation of queried numerical values etc. The MIB Compiler lets you compile any vendor specific MIB file. The compiled MIB file can then be loaded and utilized by the MIB browser. Generally, a MIB file is usually supplied by the vendor of an SNMP manageable device and contains a description of the object hierarchy and object attributes on the managed device and serves as a roadmap for managing that device. 

APPARATUS

· OpenView Network Node Manager

· SNMPUTIL Program

· MGSoft MIB Browser

· RFC 1213

PROCEDURES

Management using Command Line SNMP

In this section, you will begin your exploration of SNMP and it’s MIBs.  You will query the network using the Command Line SNMP Utility that is part of the Windows 2000 operating system.  This program will allow you to see, on a basic level, how the different machines are talking to each other and the commands they use.    
a) Log onto the workstation. Start up a Command Prompt window. (Start > Programs > Accessories > Command Prompt) Type the following to change the directory: 
cd c:\software\snmp util

b) You will now use the command-line SNMP manager to find the system contact for 6 of the other machines in the classroom.  To do this, you will use an SNMP get – request.  The general syntax is as follows:

snmputil get {host} {community} {object identifier}


      where: 
{host} is the hostname or IP address of the target;




{community} is the simple authentication name; and




{object identifier} is the object name you wish to retrieve.

c) The command line interpreter assumes you are retrieving an object from mib-2, unless the object identifier starts with a “.”.  Also, object names are case sensitive.  For example, to retrieve the value of the object sysContact from device student1, type the command:

snmputil get student1 public system.sysContact.0


Now try some other naming conventions:

snmputil get student1 public .iso.org.dod.internet.mgmt.mib-2.system.sysContact.0

snmputil get student1 public .1.3.6.1.2.1.1.4.0

snmputil get student1 public system.4.0
[Q1, 10 points] Construct a table consisting of the sysUpTime for any 6 of the devices in the TSEC network.  Include in this table the Host name and the sysUpTime.

d) Next you will use the SNMP command getnext to query MIB objects in a table without knowing the exact object identifier for the first entry in the table.  This command uses the same general syntax as the get request.  However, it returns with 2 objects: variable and value.  The Variable field is actually the address of the next sub-layer to your input {host} and the Value is the value of that next layer.  

[Q2, 4 points] What are some of the tasks that getnext can be used to accomplish that get cannot?

e)
Extended capabilities are built into this SNMP interface so that you do not have to type in long strings of get and getnext requests to access information.  Once such command is the walk that issues all the getnext commands required to read the specified branch of the MIB. Retrieve the system branch of your workstation by typing: 

snmpwalk {IP or hostname} 1.3.6.1.2.1

 f)
Retrieve the routing table of your workstation by typing:

snmputil walk {IP or hostname} public ip.ipRouteTable


g)    Repeat the above but send the output to a file by adding   > route.txt   to the end.

      Next type: snmpwalk {IP or hostname} 1.3.6.1.2.1 walkout and search the C drive for the file “walkout.txt”. 

[Q3, 2 points] From your observations:

a) What is the difference between Step e) and Step f)?

b)    Estimate how many SNMP PDUs were sent and received in order to retrieve the information in the “route.txt” output file.  Explain your answer. What is the result of the walkout command?

[Q4, 3 points] Using snmp commands and the system object-identifier, how long has tsec been up? On what day did it last go down?
[Q5, 3 points] Using snmp commands and the object-identifier ip.ipAddrTable, identify the subnet address and mask for each interface in the tsec community.

[Q6, 3 points] Using snmp commands and icmp as object-identifier, answer the following questions.  What is the total number of icmp messages received?  How many incoming messages were dropped?  Is this router healthy?  Justify your answer.

[Q7, 3 points] Using snmp commands and udp as object-identifier, compare the UDP in and UDP out packets for tsec.  Why is the UDP in always higher than the UDP out?

Management using a MIB Browser

In this section, you will explore how MG SOFT’s software deals with SNMP and MIBs.  This software, internally, is performing the same actions and utilizing the same commands that SNMPUTIL was, but it has a nice Graphical Interface.  

a) Start the MG-Soft MIB Browser application.  Once it opens, make sure that your machine’s IP address is listed in the Remote Agent Dialog box.  (Your machine’s IP address is located on the attached network info sheet.)

b) Maximize the MG SOFT MIB Browser window.  Select Tools | Discovery Window.  Click the top left-hand button to discover all of the hosts of you subnetwork. (This could take several minutes.)

c) For each discovered host, right-click on the system name and select IP to History List.   When you have finished, close the SNMP Agent Discovery window.  

d) In the MIB Tree pane, expand the branches as follows:

iso | org | dod | internet | mgmt | mib-2

e) Now, before you can retrieve information from an SNMP agent with MG-Soft MIB Browser, you must first contact the agent.  Right Click on the system branch and select Contact.  This will give you the value of the sysUpTime object in the Query Results pane.  

f) Right click on the system branch again and select walk.  

[Q8, 2 points] What is the System Uptime of your workstation?

[Q9, 2 points] What is the System Description of your workstation?

g) From the Remote SNMP Agent pull-down, select the IP address of your local hub.  Expand the ip branch in the MIB Tree pane.  Right-click on the ipNetToMediaTable branch and select Contact.  

h) Right-click the ipNetToMediaTable branch again and select Table View.  The table now displayed is the ipNetToMediaTable from the ip branch of MIB-II.  

[Q10, 2 points] What is your Ethernet physical address?

i) Now we will read the same information by walking through the MIB tree.  Close the Table window.  Expand the ipNetToMediaTable branch.  Expand the ipNetToMediaEntry branch.  Right-click the ipNetToMediaTable branch and select Walk. Compare these objects with the table you saw in the previous part of this exercise.  

[Q11, 3 points] What is the fully qualified object ID for the MIB tree leaf containing your IP address in the ipNetToMediaTable?  Remember that the MIB variable instance is also part of the object ID.  The fully qualified object ID is thus the concatenation of the path from the MIB Tree pane, up to the Type information (e.g., “octet string, ip address, etc.”).

[Q12, 3 points] Compared to the method of retrieving information with the TableView command, which interface would you prefer to work with and why?

Management using a GUI Management Tool

In this section, you will review the basics of SNMP through the use of HP OpenView Network Node Manager Software.  One way to discover nodes on a network segment is to conduct a physical inspection of the network. This process becomes too cumbersome and impractical for large networks (especially when they span a large distance) unless it is done at the time of network setup or the planning stage.  OpenView allows you to easily document your network.  

HP OpenView creates a Root submap that serves as an anchor on which an application can place a “root” symbol.  Symbols on the Root submap can open submaps that show the top-level view of a specific network, such as an IP Internet or an OSI network.  When a map is created, IP Map creates the following submap hierarchy, showing the network in increasing detail:  Internet submap, Network submaps, Segment submaps, and Node submaps.  IP Map only manages objects that exist within this hierarchy of submaps.  IP Map will not manage the objects of symbols added to the Root submap, or added outside the realm of the IP submap hierarchy.

a) Make sure you are still logged into the workstation as “snmp” with ‘management’ as the password.  Start up the HP OpenView Software.

[Q13, 2 points]  What are the shapes of object representing ATM hub, gateway, FDDI ring, token ring, and Ethernet?  Draw each. (Help > Display Legend > Symbols).
[Q14, 2 points]  What do the different colors of the object tells us? Explain them briefly.  (Help > Display Legend > Operational Status Colors).
	Operational Category

	Red
	

	Orange
	

	Yellow
	

	Cyan
	

	Green
	

	Blue
	


b) There are two ways to navigate through the submaps in OpenView.  One way is by double clicking on the icons (to go deeper) or the up arrow on the toolbar (to rise to the top level).  At each stage, configuration information about the icon can be found through the Edit Menu or Properties Button.  The other way is to go directly to the desired submap by using the “Open Submaps...” option under the Window Menu. Try both ways of moving around.

[Q15, 3 points]  What are the advantages associated with each navigational method? Explain them briefly.

[Q16, 5 points]  Information about each individual device in a network can be stored in different places and accessed by different people as necessary.  If you were the network manager of a large remote network (i.e. spanning the state of Georgia), what type of non-technical/non-networking information would you find useful to know about your network’s devices?  How would you normally find out this information if you did not have access to a software package similar to OpenView?

c) Go to Options, then Report Configuration.  This will open up a new window in which you can generate various network reports to be emailed.  (If this report editor fails to load, check your internet connection and return to this question later).  Choose a relevant category in the window and have the software send you a report on the status of the network.  Spend a little bit of time scrolling through this feature.

[Q17, 2 points]  What is the System Uptime of your workstation?  What is the System Description of your workstation? 

d) Now choose to look at a MIB value that also has the ability to graph the information.  Once that title is highlighted, click on the graph button.  If you need a precise time from the graphical information, left click anywhere on the graph and hold the button as you move the pointer.  This will display the time value associated with the information under the pointer.  

[Q18, 4 points] Why would this be a useful feature and where is this feature currently incorporated into the Windows NT system?

NOTE:  Include all above questions in your group report.  Include the Discussion Questions (below) in your individual report.

DISCUSSION

[Q19, 5 points]  Given the following information, calculate the availability for the following network devices.  Show your calculations:


a.
PBX Switch:  Never goes down, but once a year the technician unplugs everything “to give it a good cleanin’.”  He does this only at night, between 0200 and 0230 on July 4th.

[Q20, 10 points]  Define the following object types:

a.
Counter64

b.
Integer

c.
the BITS construct

d.
Gauge32

e.
Opaque

[Q21, 5 points]  Explain the difference between a MIB (which resides at a managed device) and a Network Management Database (which resides at the management workstation).

[Q22, 5 points]  For the following availability rates, determine the corresponding amount of monthly downtime in minutes:


a.
99.9%


b.
99.99%




c.
99.999%



d.
99.9999%


e. 99.987%

[Q.23, 5 points]  What is BER?  What other encoding technique could have been chosen for SNMP?  Why was BER chosen?

[Q.24, 5 points]  What is LMI (Local Management Interface)?

[Q25, 12 points]  Which companies / organizations are assigned the following private enterprise mib trees:

a.
1.3.6.1.4.1.74

b.
1.3.6.1.4.1.99

c.
1.3.6.1.4.1.276

d.
1.3.6.1.4.1.326

e.
1.3.6.1.4.1.576

f.
1.3.6.1.4.1.1569

[Q26, 5 points]  Consider the following network diagram.  The numbers represent down time for the particular device over the previous month.


What is the network availability:

a. if all the devices were down at the same time?

b.
If all the devices were down at different times?
[Q27, 5 points]  Name the five major functional areas of network management.  Which ones traditionally emphasize monitoring?  Which ones traditionally emphasize control?
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